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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by 
Mac NZ for this purpose only. Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

March 2017  
•2——Mac News ~ iCloud 

extortionists, Apple Stores, AR 
glasses, Flikr, India, safe data, 

forestry, Apple I  
•4——Updates ~ Blanker, iTunes, 

LG UltraFine finally sorted,  
& new versions of  every OS 

•7——Mac Help ~  
Around New Zealand 

•8—— iOS & iDevice news ~ 
iPhone 7 (RED), Wellington Apple 

Lab, AR glasses, Workflow, new 
iPad, iPhone 6s success 

•9——Apple & Talk ~  
Apple pays no NZ tax,  

& Siri vs NZ silence  
•12——Tips & Tricks ~  

Mac tidy, smarter Mail sends,  
Do Not Disturb, iOS Messages 

& more Mac Finder tips 
•16——Shiny & New ~ New  

9.7-inch iPad, RED iPhone 7 
new cases for iPhone & iPad

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

Apple has introduced  a new iPad that fills the space of the iPad Air and (the normal middle model) iPad. The 2017 iPad has an 
A9 processor which is a step up from the iPad Air 2, but a notable step down from the iPad Pro.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.creativetech.net.nz
http://www.mac-nz.com
http://www.mac-nz.com
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Mac News > iCloud extortionists fail, claims Apple > Apple Stores mapped

iCloud extortionists fail
Hacker group Turkish Crime Family says it’s 
going to wipe out over 300 million iCloud 
accounts on April 7th if Apple doesn’t 
pay US$75,000 as ransom. Apple says the 
group hasn’t broken into its servers, so 
that means the log ins they claim to have 
probably came from old hacks into other 
company’s services.
Many of the log ins on Turkish Crime 
Family’s list look like they may have 

More news is online at Mac NZ

come from a 2012 LinkedIn data breach 
where over 100 million accounts were 
compromised, according to someone 
claiming to have seen the list.

Apple Stores on map
Check out Apple Stores Worldwide, an 
interactive map showing the impressive 
expansion of Apple stores by Retale.com. 
It’s a map of the globe that shows the 
year-by-year expansion of Apple’s fleet 

of retail stores. Each one blossoms like 
a nuclear hit in a war game, and you can 
hover over any one of them to get details 
about the store.

Mac commentators & Apple tax
Apple is a master of making profits, and 
an expert and keeping its money out of 
government hands. Bryan Chaffin and 
Jeff Butts join Jeff Gamet to offer their 
thoughts on Apple’s tax practices in 

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/news/apple-icloud-extortionists
http://www.mac-nz.com
http://www.istorenz.com
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Mac News > AR glasses, retrieving from Flikr, India expansion, safe data, Apple I

New Zealand and other countries in this 
podcast you can listen to at this link. 
My take, meanwhile, appears later in this 
issue under Apple Talk. 

Getting your photos from Flikr
Flickr is great for storing and sharing 
photos online, but what do you do when 
you want to download them to your 
computer? [And people wonder why I’m 
leery of cloud services ...]

Spaces in macOS Sierra
 It’s easy for your Mac’s desktop to become 
cluttered, just as a physical desktop can. 
If this happens, you can create additional 
desktops, called spaces, to organize the 
windows. When you work in a Space, you 
see only the windows that are in that 
space. Here’s how Spaces works.

Retail expansion in India
 Apple is planning to grow its presence 
in India over the next year by expanding 
the number of Apple Authorized Reseller 
locations, with the addition of over 100 
small stores believed to be a six-fold 
increase in the number of outlets already 
in operation in the country.

How to protect your data
By most accounts macOS and iOS are 

safer operating systems than Windows or 
Android. However, there was a dubious 
2015 report from GFI that claims the 
Apple operating systems were the “most 
vulnerable” OS’s. 
This may not be in the least bit true, but 
there are good reasons to protect your 
data from loss and from prying eyes [but 
be careful turning Apple’s FileVault on, as 
it can lock you out. If it’s not on already, I’d 
find another solution!]

Apple’ forestry
Two years ago, Apple bought 3600 acres 
in Brunswick County, North Carolina. 
According to The Conservation Fund,  
the Arlington, Virginia-based group Apple 
tapped to manage the effort, the project 

is starting to show 
returns  for Apple 
and North Carolina.

Apple I
Team Breker 
announced this 
week it had a Apple 
I computer up for 
auction: the “best-
preserved example 
of an Apple-1 
computer to appear 
on the market.” 
It may fetch 
US$325,000!

More news is online at Mac NZ

Funny to think a single iPhone is way more powerful than all this

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macobserver.com/podcasts/apple-new-zealand-taxes-tmo-daily-observations-2017-03-20/
https://www.macobserver.com/cool-stuff-found/how-to-download-flickr-photos
https://www.macobserver.com/cool-stuff-found/how-to-download-flickr-photos
https://www.appleworld.today/blog/2017/3/20/how-to-work-in-multiple-spaces-in-macos-sierra
http://appleinsider.com/articles/17/03/17/apple-plans-retail-expansion-in-india-with-over-100-new-authorized-resellers
http://appleinsider.com/articles/17/03/17/apple-plans-retail-expansion-in-india-with-over-100-new-authorized-resellers
http://www.macsense.co.nz
http://www.mac-nz.com
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Screen Commander ‘screen blanking’ for the Mac
Alien Orb Software has introduced Screen Commander 1.0, a 
screen blanking utility for macOS. Developed for users with 

multiple displays, it lives in the 
menubar as a small icon and provides 
screen blanking options at the click 
of the mouse. 
Screen Commander requires macOS 
10.12 or later. It’s freeware and is 
available exclusively at the Mac App 
Store, for free.

iTunes 12.6 with cross-device movie rental
Apple has released iTunes 12.6, the next major update for the 
iTunes app on Mac devices. 
iTunes 12.6 introduces a “Rent once, watch anywhere” feature 
that lets iTunes users watch iTunes movie rentals across all 
devices with iOS 10.3 or tvOS 10.2. 
Prior to this update, an iTunes 
movie was only available on a 
single device at a time. 
When a movie rented on a Mac 
was transferred to an iPhone, 
iPad, or iPod using USB, the movie 
became unavailable from an 
iTunes library until returned to the 
Mac.
The new iTunes 12.6 update can 
be downloaded from the Mac App 
Store for free, where it will appear 
under Updates.

Updates > Blanker, iTunes adds back multi-access rentals, LG UltraFine saga sorted

LG UltraFine 5K saga over
 Continued testing of the LG UltraFine 5K 
displays has discovered that while the new 
monitors are still very slightly sensitive 
to high-powered RF emissions from very 
close cell towers or military radars (like 
any monitor), the interference problems 
are rectified. Older monitors have been 
retrofitted by authorized third parties and 
these are even less sensitive to the same 
emissions. 
The vast majority of users won’t see a 
problem, but users within about 50 feet 
of an active cell tower, or a civil or military 
radar installation are experiencing the 
disconnect issues – 99.9 percent of users 
won’t ever be put in this position.

Next page — a multitude of OS updates

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.appleworld.today/blog/2017/3/20/screen-commander-is-new-screen-blanking-software-for-the-mac
https://itunes.apple.com/app/screen-commander/id1213310371
https://itunes.apple.com/app/screen-commander/id1213310371
http://www.macsense.co.nz
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macOS Sierra 10.12.4
Apple has released macOS Sierra 10.12.4 after weeks of public 
and developer beta testing. macOS 10.12.4 brings iOS’s Night 
Shift mode to the Mac, allowing users to cut down on blue light 
exposure. It also includes Shanghainese dictation support, cricket 
scores for Siri, and PDFKit improvements.
The update can be downloaded using the Software Update 
function in the Mac App Store, and requires a full restart.
The best way to do this is: first, make sure you have a recent 
backup – preferably Time Machine – then run the update, restart 
(the system will do this automatically), open 
the Utilities folder in the Applications folder, 
open Disk Utility (this is Apple software), 
select your hard drive on the left, click the 
First Aid tab, run First Aid, and when it’s 
finished (this could take 20 minutes) restart 
again.
This is the most reliable way to update 
macOS system software.

iOS 10.3 with Find My AirPods, More Siri, APFS
Apple has shipped iOS 10.3, a significant update to the company’s 
mobile operating system. Major features include the ability to 
find your AirPods under Find My iPhone; new Siri integration with 
third party apps; new CarPlay features, including daily curated 
playlists from Apple Music; and perhaps most importantly, the 
official rollout of Apple File System (APFS).
iOS 10.3 is a 613.7MB download as an over-the-air update on 
iPhone 7 [which means you need to stay in a secure wifi zone 
while you do so and can’t leave till it’s finished, for best results], 
or a 2.39GB download through iTunes for an iPhone 7 [in other 
words, you run the update via a Mac or PC plugged in directly 

Updates > macOS 10.12.3, iOS 10.3, watchOS 3.2 and tvOS 10.2 all arrived together

via an iPhone USB Charge Cable – a faster and preferable way to 
update iDevices, in my opinion]. 
iOS 10.3 introduces new features including the ability to locate 
AirPods using Find My iPhone and more ways to use Siri with 
payment, ride booking and carmaker apps.

watchOS 3.2 adds Theater Mode and SiriKit 
The former lets Apple Watch owners disable the “rise to wake” 
function on the watch, but still notify them with haptic feedback 
of notifications without illuminating the watch display.

SiriKit enables apps to work with Siri, Apple’s 
“personal digital assistant,” so users can get 
things done with content and services using 
just their voice. In addition to extending 
Siri’s support for messaging, photo search 
and phone calls to more apps, SiriKit also 
adds support for new services, including ride 
booking and personal payments. Upgrade 
to watchOS 3.2 via the Apple Watch app on 
iPhone.

tvOS 10.2 
This update provides an accelerated scrolling feature to the Siri 
remote so you can scroll through lists of content faster. The OS 
update also adds the TV app, which is designed to offer a unified 
experience for discovering and accessing TV shows and movies 
from multiple apps on the iPhone, iPad, and Apple TV. It provides 
one place to access TV shows and movies, as well as a place to 
discover new content to watch.
To upgrade your Apple TV (and you’ll need the fourth-generation 
of the set-top box), go to the Settings menu, selecting System, 
Software Updates, then Update Software.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
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U S B - C  t o  U S B  C a b l e
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

I o n G l a s s  f o r 
i P h o n e  7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

U S B - C  t o  V G A  a d a p t e r
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees a 
hassle-free setup for convenient home or office use
NZ RRP$69.99

U S B - C  C h a r g e  C a b l e
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with an Apple 
Retina MacBook, Google Chromebook Pixel, or 
any mobile device equipped with a USB-C port. At 
2 metres length (6.6 feet) in length, a HandyStrap 
is also included to keep your cable neat and tidy 
during transport 
NZ RRP$59.99

a r m o u r  f o r  i P h o n e 
6 -7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-ion-glass-for-iphone-7-plus
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-vga-adaptor
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-iglaze-armour-for-iphone-7
http://www.macgear.co.nz
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Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac & iDevice training in 
Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac NZ 
– but I sometimes run Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. 
Please email if you are interested in 
attending, as I only book a room when I 
can guarantee five attendees. 
The sessions are friendly, open to 
questions at all times and are backed up by 
‘tip sheet’ handouts. 
I can and do train one-to-one or to small 
groups at your home or workplace in 
Auckland. This costs $95/hour. 
I can present to institutions on Mac and 
iDevice: tips, tricks, hidden features, 
demystification ...Email Mark for info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help > Apple assistance, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.apple.com/support/
http://www.apple.com/nz/findouthow/mac/
http://www.apple.com/nz/findouthow/mac/
http://www.apple.com/nz/service/
http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
http://www.apple.com/nz/support/products/mac.html
http://www.seniormac.org.nz
http://www.seniormac.org.nz
http://www.macsnrs.org.nz
mailto:%20macseniorauckland%40mail.com?subject=Enquiry%20via%20MagBytes%20about%20SeniorNet
http://www.seniornet-eden-roskill.org.nz
https://macnzmark.wordpress.com/training/classes-in-grey-lynn/
mailto:mac.nz%40mac.com?subject=Grey%20Lynn%20sessions
https://macnzmark.wordpress.com/training/one-to-one-visits/
https://macnzmark.wordpress.com/training/business-corporate-academic/
mailto:mac.nz%40mac.com?subject=Please%20tell%20me%20more%20about%20training
http://www.mac-nz.com/help_.html
http://www.mac-nz.com/help_.html
mailto:Dave%20Boswell%20%3Cdaveboz%40xtra.co.nz%3E?subject=Query%20from%20MagBytes
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iDevice news

Logitech ad

RED iPhone
Apple’s new red options for the 
iPhone 7 and 7 Plus, which, through 
(Red), will contribute proceeds to 
the Global Fund to fight HIV/AIDS

Apple & Wellington AR lab
Apple has opened an office in 
Wellington to develop augmented 
reality technology.
Bloomberg reported Apple had 
lured several employees from 
Wellington special-effects firm 
Weta Digital to its venture.
Former Weta Digital special effects 
Oscar winners Simon Clutterbuck 
and Richard Dorling are now 
working for the firm.

Apple and AR Glasses
Apple seems to have a very real 
interest in augmented reality, 
which would likely be headed to 
the iPhone. It seems the company 
is exploring AR glasses, like Google 
did with Google Glass, and will 
target our eyes after tackling the 
iPhone.

> New RED iPhone, Wellington Apple lab, Apple glasses, Siri

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
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iDevice news> Apple acquired Workflow app & made it free, new iPad, the 6s

Siri saves boy’s mum
Siri is an AI with a lot of talents, and it 
teamed up with Roman, a 4-year-old boy 
in the UK, to help him get help for his 
mother. Roman unlocked his mother’s 
iPhone by pressing her thumb to her 
iPhone’s Touch ID home button, then 
asked Siri for help.

Apple acquired Workflow 
Apple recently acquired popular iOS utility 
Workflow, according to TechCrunch. 
The deal includes both the app and its 
developers. 
While many apps get pulled by Apple 
after an acquisition, Workflow remains 
on the App Store, but is now free instead 
of US$2.99. Workflow is a personal 
automation tool, enabling you to drag and 
drop any combination of actions to create 
powerful workflows for your iPhone, iPad, 
and Apple Watch. (But some features have 
been cut from the app.)

New iPad for Air & ‘normal’ iPad
The new iPad is a compelling, inexpensive 

upgrade for users 
of the iPad 4 and 
earlier which 
comprises 30% 
of the existing 
user base. 
However, the 
iPad Air and Air 
2 owners hold 
a commanding 
35% of iPad users 
who may be 
looking at the new iPad as well.
iPad comes in silver, gold 
and space grey and starts at 
recommended retail price (RRP) 
NZ$539 inc. GST for the 32GB with 
Wi-Fi model and RRP NZ$759 inc. 
GST for the 32GB Wi-Fi + Cellular 
model at Apple. There are also 
new Polyurethane Smart Covers 
for iPad are available for RRP 
NZ$69 inc. GST in charcoal grey, 
white, midnight blue, pink sand 
and (RED), above (Images this 
page: Apple Inc).

More news is online at Mac NZ

iPhone 6s topped 2016
In terms of shipments, the iPhone 6s from 
Apple bested all competitors for sales in 
2016, according to new analysis from IHS 
Markit, a “critical information, analytics 
and solutions” firm.
Looking at the fourth quarter alone, the 
new iPhone 7 was the 2016 best-seller, 
followed by iPhone 7 Plus. IHS Markit 
says Apple again demonstrated its new 
iPhones integrate enough innovations and 
new features to drive sales and remain 
successful in the market.
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apple&talk > Apple pays no New Zealand tax – because Australia gets it

First of all, lots of people don’t 
like paying tax. Neoliberals and 
conservatives in particular seem to 
have massive issues with ‘having’ to 
pay tax, although they seem to have 
no problem driving on the roads 
those taxes paid for, being cared for 
by public medical services or taking 
advantage of public education, or 
at least of education subsidies paid 
on their behalf from tax revenue 
so their little darlings can benefit 
from private school educations that 
advantage the advantaged.
But that’s partly what I find so odd 
about Apple apparently paying ‘no’ tax 
in New Zealand: Apple has a reputation 
for supporting democrats, standing 
up for equality and strongly pursuing 
sustainability ambitions. None of these are 
exactly ‘neoliberal’.
However, Apple is also a typically rapacious 
US corporation with its eye firmly on profit. 
There’s a reason these companies have 
billions, you know. 
Apple will do almost anything to defend 
its interests, ruthlessly cut product lines 
and teams that don’t satisfy this urge for 
ever more money and, seemingly, exploit 
any avenue that leads to even more money 
on the extremely wealthy corporation’s 
bottom line.

But what’s the truth about Apple and 
New Zealand tax? Sure, Apple makes 
money in New Zealand. It’s a tiny territory 
and hardly a big factor in Apple profits, 
although New Zealand has always been 
relatively high in Mac use, then iPhone 
adoption.
But ‘Apple New Zealand’, although it has 
an office in Auckland and staff on the 
ground here, is actually run out of Sydney, 
Australia as part of ‘Apple Pacific’ which, 
in turn, reports directly back to Cupertino 
(or at least, this was the case last I heard). 
So Apple pays its tax in Australia, and not 
New Zealand. This actually means Apple 
pays more tax, not less: if Apple operated 

this subsidiary out of New Zealand 
it would be paying tax at 28%, but 
because it’s based in Australia, it’s 
subject to tax at 30%, as Seamus 
Coffey asserts.
Look, I’m not advocating tax 
avoidance – in fact, the idea makes 
me sick. You choose to live in a 
society, and you pay your dues. 
Otherwise, leave. If I can pay tax 
on my tiny income, Apple can pay 
tax on its massive one. Of course, 
corporate tax is paid on profit, not 
sales (apart from the New Zealand 
Goods and Services Tax or GST, 

which Apple does pay even on online sales).
Apple has not paid any income tax in 
New Zealand for the last ten years in New 
Zealand, but it has paid out $37 million 
from NZ sales to the Australian Tax 
Office instead of to New Zealand’s Inland 
Revenue.

But the issue is being ‘investigated’ 
by National minister Judith Collins. 
You know, the one whose husband runs 
Oravida, which is making millions out of 
selling free New Zealand water by bottling 
it and moving it overseas. So yeah – kettle, 
pot, black … Of course, none of this excuses 
Apple from its tax avoidance elsewhere. 
That totally sucks.

(Images cribbed from RNZ site)
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apple&talk > Siri and NZ’s Silent Division

Do you have your Siri set to a male or 
female voice? Personally, I prefer female. 
Possibly that’s because I had two daughters 
and even the cat’s a girl, so I’m used to 
being told what to do by female voices. 
[OK, that’s a joke. Honestly.]
No, I just prefer it. Whether it’s easier to 
understand and clearer, I don’t know. But 
do please note that Siri can not only be 
set to the New Zealand English accent – in 
other words, to better understand New 
Zealanders –  it can also be set to either of 
two genders and even to other languages. 
My current choice is an Irish female voice, 
partly because it’s so pleasant. You can 
do this in Settings>Siri, and on the Mac, 
System Preferences>Siri.

Regardless, we now have digital 
assistants with us all the time. And 
they’re literally a voice summons away.
And they’re literally iterated all over the 
place – Apple shipped 78 million iPhones, 
13 million iPads, and 5.4 million Macs just in 
the last quarter.
All of them have Siri. This doesn’t even 
include Apple Watches and, of course, 
Macs. The research firm Canalys estimates 
Apple sold 6 million Watches last quarter. 
All in all, that’s over 100 million Siri enabled 
devices in one quarter. S/he’s literally 
everywhere.

Of course, there are rivals. Consumer 
Intelligence Research estimates Amazon 
sold 5.2 million Amazon echoes … for all 
of 2016. Ouch. And there’s Microsoft’s 
Cortana.
As I just explained to a SeniorNet group 
in Auckland yesterday, Siri on your Mac is 
particularly handy, for doing Maths (I love 
this! Asking for a percentage of a number, 
for example, is way easier than mucking 
about with a calculator). But you can also 
use it to find file, launch files and apps and 
open folders, and even to start playing 
iTunes music. Want to find something on 
the web? Launch Siri, say ‘Find me news 
about flooding on the web’.

Once you start doing things like this, 
you start considering if trackpads and 
mice will be necessary at all soon. For 
many of us who don’t mind the sound of 
our own voices, this is a strikingly fast and 
convenient way to do oh so many things.
I only worry about walking down the 
street and yakking to my iPhone in public. 
After all, us Kiwis are a reticent bunch – 
New Zealand soldiers in World War One 
famously stopped singing when they came 
to a village, to resume a safe distance 
away on the other side, earning them the 
nickname amongst Belgian and French 
villagers of ‘The Silent Division’.
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> Some Mac tidiness tips for your Autumn Cleaningtips&tricks

1/ Minimise apps into their icons — You 
can click the yellow pill button in the 
upper left corner of a window to minimize 
an app’s window into the Dock in macOS 
Sierra, but if you minimize a lot of 
windows, the right side of the Dock quickly 
becomes cluttered.
The solution is to minimise windows into 
their app icons.
Open System Preferences from the 
Apple menu and choose Dock. Check 
the box next to ‘Minimize windows into 
application icon’ (shown above). Now they 
minimise down into the originating app’s 
icon – click-and-hold on that in the Dock 
to see your files (below – I have my Dock 
on one side instead of at the bottom to get 

more screen real estate on my Mac screen, 
but it works the same no matter where 
your Dock is). 
If you have a lot of minimised app 
windows, and have trouble finding what 
you’re looking for, control-click (hold 
down the Control key on your keyboard 
and click) the app icon to reveal a list of 
that apps minimized windows. Choose an 
item from the list and it will open.

2/ Group windows by application in 
macOS Sierra — macOS Sierra introduced 
system wide tabs for most (but not all) 
apps, allowing you to merge multiple 
windows into a single window or separate 
merged windows.
With two or more windows of a supported 
app open, go to the Windows menu in the 
Finder and choose ‘Merge All Windows.’ 
All windows of the same app will be 
grouped into a single window. Each file you 
have open will appear as a tab inside the 
single window.
To separate the merged windows into 
standalone windows of their own, select 
the merged window to make it active. Go 
to the Windows and click the ‘Move Tab to 
New Window’ option. Click it to move the 
selected tab to a separate window.
This won’t separate all tabs into windows 
of their own, but separate the current tab 

to its own window. All remaining tabs 
will remain grouped into a single window 
unless you separate them one at a time.
Click the close button on a merged 
window, and it will close all tabs you have 
open in it.

3/ Move multiple Events between 
Calendars — If you’ve got several events 
you need to move to a different calendar, 
change to month view by pressing 
Command-3 or click on the Month option 
in Calendar’s toolbar or at top-centre 
of Calendar. Find the events you’d like 
to move, hold down Command on your 
keyboard and click on each one to select 
them all in turn. When the events are all 
highlighted, right- or Control-click on any 
one of them. From the contextual menu 
that appears, choose the ‘Calendar’ option 
and pick the one you’d like to move your 

... continues

Multiple events can be selected, but you can’t drag them
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tips&tricks > More for macOS: smarter Mail sends, Do Not Disturb, folders, text

selected events to. Simple.

4/ Multiple ways to move items to 
Trash — In Finder, you can simply drag 
item(s) to the Trash icon in the Dock, or 
move highlighted file(s) to the Trash with 
the keys Command-Delete. If you make a 
mistake, Undo the operation by choosing 
File>Undo, or Command-Z.
To delete highlighted items immediately, 
hold down the Option key and select 
File>Delete Immediately…. or the 
keyboard combo Command-Option-
Delete. You’ll receive a confirmation 
dialogue that the operation is permanent 
and can’t be undone.

5/ Empty stubborn Trash items — 
If there are files in the Trash, which you 
can confirm visually because you’ll see 
items in the Trash, you can empty it by 
either choosing Finder > Empty Trash…, or 
using keyboard combo Shift-Cmd-Delete. 
You’ll be presented with a confirmation 
dialogue asking if you’re sure. You can 
also hold down Option and select Finder 
> Empty Trash, or use keyboard combo 
Shift-Option-Command-Delete. Notice 
that since there isn’t a trailing ellipsis after 
the choice, it will be done immediately 
without a confirmation dialogue. [If this 
still doesn’t work, you’ll need Terminal.]

1/ Automatically select best account to 
send from in Mac Mail — 
Apple Mail received a new feature in 
Sierra that automatically chooses the 
best account for you to send a new 
message from, based on who your email 
is addressed to and what mailbox and 
message you had selected when you 
started composing.
To turn this on (or off) open Mail’s 
Preferences from the menus at the top. 
Use the Composing Tab in Mail Preferences 
to access your settings for sending 
messages. Under the Composing tab, 
you’ll see a drop-down next to “Send new 
messages from” (shown above). Pick that 
to view your options. 

You might almost always want to send 
from your work email address, but if you 
want to try out letting Apple Mail pick 
for you, then toggle that drop-down to 
“Automatically select best account.”

2/ Enable Do Not Disturb in macOS to 
silence notifications — Notifications can 
be a mixed blessing. For some they keep 
the chaos of communications down and 
allow for rapid response to an email or 
a Tweet, but for others they can be an 
annoying distraction.
You can silence notifications until 
midnight quickly, with a single click. To 
get that done, option-click (hold down 
the Option key on your keyboard while 
you click) on the Notifications icon in the 
upper-right hand corner of the desktop.
To show that Notifications are muted, 
the icon becomes greyed out. When the 
icon is greyed, you can still invoke the 
Notifications tray by clicking on the icon 
again — but this won’t un-mute them.
To do so, either pop open the Notifications 
tray and turn them back on with the 
toggle, or option-click on the Notifications 
icon in the menubar again.

3/ Who can and can’t bother you — If 
you want more precise control over what 
gets to bother you, delve into the settings 
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tips&tricks > macOS tips continued              iOS Messages features and quirks 

of the feature itself. Select System 
Preferences from the apple Menu (or 
from the Dock). In the upper right hand 
corner of the system preferences, select 
Notifications. From this menu, most 
parameters of Notification Center are set. 
Setting the schedule for notifications to 
not bother you at all during working hours 
is a good solution for the easily distracted.
There are other settings here, such as the 
ability to turn them off when the display 
is being mirrored for a presentation, or to 
allow for a particularly persistent caller 
to break though your need to not be 
disturbed.
However, another option to quiet the 
tumult is to tell the most frequent 
offender to not pop up a notification. 
Select whatever app you wish to silence 
from the left hand column, and turn it off, 
or pare down when it will yell at you.

4/ Set folders in the Notes app — There 
aren’t a lot of ways to organize notes in 
Apple Notes, which became so much more 
powerful in Yosemite. 
But you can set folders and subfolders 
– clock the Elis icon at lower left in the 
Notes window to create a folder. There’s 
no obvious way to create a subfolder, but 
in fact all you do is drag one folder into 
another.

Keep in mind that if you delete a folder, 
then all of the subfolders and notes will 
also be deleted.
(Unfortunately, it’s not possible to create 
subfolders in iOS Notes. But if you create 
your subfolders on macOS, they do sync 
over to iOS.)

5/ Text selection tricks — Clicking 
anywhere within text in a document 
places your cursor there for deleting or 
adding to what you’ve written. While 
you can click and drag to select text, 
sometimes this means you miss a few 
letters. If you want to just select one word, 
it’s much faster to double-click it.
A triple-click selects the entire paragraph 
your cursor is on.
More sophisticated still: hold that final 
click and move your cursor – the selection 
jumps by full words or full paragraphs 
each time … no missing letters.

1/ In Messages, use the full-screen 
camera — When you’re messaging with 
someone from your iPhone, you can tap 
the arrow next to the typing field to access 
your pictures with the little camera icon 
that’ll appear. Once you’re in that camera 
mode, though, all you’ll see is a few of 
your recent images and a tiny viewscreen 
on the iPhone. That small little viewfinder 
panel, however, lets you swipe from left to 
right (see that little left-punting arrow on 
the left, above?) to reveal another couple 
of options: a full-screen camera viewfinder 
and access to your whole Photos library 
(below). 
Now you can use your full-screen camera 
within Messages or look through your 
entire photo library on your device, so if 
there’s a picture from a few months back, 
you don’t have to switch apps to find it.
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tips&tricks > Quirks and tips for iOS Messages continued, and Activation Lock 

2/ Share your location — There’s a really 
quick way to share your location with 
someone you’re messaging, so they can 
know where you are or how long it’ll take 
to get to you: tap the small ‘i’ at the top of 
any Messages conversation. 
This reveals the Send My Current Location 
feature. That’ll immediately pass along 
your location info into the chat, and your 
recipient can then touch that map to get 
directions right to where you are.

3/ Draw on videos — To add lines, circles, 
arrows etc within Messages to videos and 
images, tap the arrow and then touch the 
heart icon. Tap the Video Camera button, 
and you can draw on your screen to 
highlight whatever you like.
You can either draw before you start 
taking a video, which will superimpose 
your drawing over what you record, or 
you can draw during video-recording to 
highlight something at a specific moment.

4/ See which number someone used — If 
you’re not sure which number or email 
address is the correct one to use for 
texting with a contact, you can tell within 
the Messages app by seeing which one he 
or she has used recently. Start by tapping 
their name at the top of your conversation 
to access their contact info.

When that appears, look for which 
number is marked Recent.
[These tips came from Melissa Holt at the 
Mac Observer.]

5/ How to still check an iPhone’s 
Activation Lock — Apple deleted its 
iCloud Activation Lock status check tool 
from its website earlier this year. That was 
a simple, effective method of checking 
whether a used iPhone, iPad, iPod or Apple 
Watch was stolen. But a newly discovered 
workaround promises an alternative 
online resource for buyers in the market 
for second-hand iOS devices.
Apple’s online checker involved entering 
an IMEI, so the tool served as an ideal 
source for generating valid serial numbers. 
It has been theorized that Apple scrapped 
the online resource to better protect its 
customer base.
But owners or potential buyers can still 
check Activation Lock status by IMEI 
through Apple’s own support pages. Be 
forewarned: the workaround’s success 
is spotty and it might be completely 
removed from Apple’s website at any time.
First, visit Apple’s Support website and 
select iPhone. Click on a search category 
related to hardware, for example Battery, 
Power & Charging or Repairs & Physical 
Damage, then select a specific problem 

like ‘Buttons not working’.
On the next page, you should see an 
option to Send in for Repair. If the item is 
not listed, go back and select a different 
device problem from the previous screen. 
Clicking through Send in for Repair will 
retrieve a page that allows users to ‘Enter 
your serial number, IMEI, or MEID’.
[These numbers, by the way, are in on your 
iPhone and iPad and iPod Touch under 
Settings>General>About. You should 
record these or take a screenshot of the 
page by pressing the Home and Sleep 
buttons at the same time and emailing the 
image your iDevice records to your Photos 
library to your Mac or PC.]
Enter the IMEI of a target device to check 
its Activation Lock status. It should be 
noted that the described method is not 
always successful. In some cases, Apple’s 
website will direct users to sign in with 
their Apple ID, which the company 
normally uses to facilitate service with 
linked iCloud devices.
The workaround seems to be a carryover 
from the days when iCloud Activation 
Lock status was a thing. It remains unclear 
how long the loophole will remain active 
in its current form, as Apple appears to 
be — slowly — transitioning the entire 
Support website to lead directly to users’ 
Apple ID accounts.
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tips&tricks > More Finder tips to help you wrest back control of  Mac behaviour

1/ Configure a Public Calendar — Using 
iCloud, you can set up a public calendar. 
This is different from the typical iCloud 
calendar sharing in which all participants 
can usually edit and add events 
themselves. Depending on how you set 
the permissions, a public calendar will 
instead show anyone with its link all of 
its events but won’t allow them to make 
any changes. While this used to be only 
available to iCloud users, now PC users can 
also access these public calendars as long 
as they’ve got a program that supports 
iCalendar files (and Microsoft Outlook, for 
example, does).
Open Calendar program on your Mac, 
and decide whether you’d like to use an 
existing calendar or create a new blank 
one. Keep in mind that anyone with the 
link will be able to view all of the events you 
add to this calendar, so if privacy’s a big 
concern, then I would start with a blank 
one to be sure you haven’t added anything 
in the past: File>New Calendar from the 
top menu. Name your creation within the 

sidebar and press the Return key to accept 
the name, then hold down the Control 
key on your keyboard and click on that 
calendar name in the sidebar to get the 
pop-out menu (shown above).
Click that, and you can set the calendar’s 
sharing.
Now you need to send the link that 
appears to the right of ‘URL’ to the people 
who might like to subscribe. You can do 
that by clicking that little Share Sheet icon 
to the right of the link, which gives you the 
usual choices for messaging or emailing 
that info, or you can just copy the link 
from that box and paste it in somewhere 
to send it.
When your recipient clicks the link on a 
Mac, they will see something like ‘Allow 
Permission’. If permission is granted, 
Calendar will open and offer to subscribe 
to your Calendar. (There’s more about 
this at Mac Observer, although the writer 
may have been using an older version 
of Calendar as her prison are slightly 
different to the latest setup detailed 
above).

2/ See the 
hierarchy 
of your File 
Locations 
— Clicking 

on the name of a file may give you some 
options for what to do with it, depending 
on what program you’re in. However, 
you can also right-click, Control-click, or 
Command-click on title bar of a file in the 
Finder to see a hierarchical view of where 
that file lives. 
This works in tons of places around your 
Mac, too. When you’ve got that little box 
open, you can click any of the folders 
shown to jump right to it.
One place this is unexpectedly helpful is in 
Mail. If you’re one of those who double-
clicks to open emails into their own 
windows, a simple Command- or Control-
click of its subject at the top will reveal its 
full hierarchical location.
You can do this all around macOS, but 
Microsoft Office is an outlier. You can still 
see the same info using this trick in those 
applications, but not with a Command-
click. Only a right- or Control-click will do.

3/ Mac Safari tabs — macOS has long 
had a keyboard shortcut for restoring 
Safari tabs. All you have to do is press the 
Command key and while it’s held down, 
the Shift key – and while they’re both held 
down, the T key in old versions of OS X …
but in macOS Sierra, you can hold down 
Command and Shift, and press T multiple 
times to restore multiple tabs.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes


>>

>
>

Mac NZ

page

17

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#85

tips&tricks > More Finder tips to help you wrest back control of  Mac behaviour

4/ Folder tabs — If you’re happily using 
Safari tabs (and you really, really should 
be) why not do the same thing in the 
Finder? 
Each Mac folder window is capable of 
using a tabbed interface, perfect for 
juggling multiple open folders within the 
same window.  But because tabs generally 
don’t appear in a folder window unless you 
specifically add them, it’s easy to miss that 
Mac folders now have tabs. 
Once you get used to them, though, 
you’ll love ’em. If a folder contains any 
subfolders, right-click (of hold down the 

Control key on your keyboard and normal-
click) on one of those subfolders, then 
select Open in New Tab.
When you do, a new folder tab will appear 
in your original folder window, just like a 
new browser tab would in Safari.
You can switch folder “views” (icon, list, 
columns, etc.) in one tab while keeping 
the folder views different in other tabs, 
and you can also navigate to a completely 
different folder within a tab. 
To rearrange your tabs within a folder 
window, click and drag a tab, just as you 
would in a Safari browser window, and 
drag it left or right.
To turn a tab into a separate window,  
click a folder tab and drag it out onto the 
desktop; when you do, it’ll snap into its 
very own window.

5/ Use tabs to rearrange where files are 
— You can also drag files from one folder 
tab to another: click and hold a file in 
one folder tab and drag it onto the tab of 
another folder for very fast file sorting. 
When you do, the top of the second folder 
tab will flash briefly, and then the tab 
itself will open; once it does, just drop the 
file wherever you’d like it to go in the tab.

And here’s an extra tip: right-click or 
hold down your Command key and click 
on a Tab’s title bar to get other tab options 
(above). 
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shiny&new > New iPad reshuffles iDevice lineup; RED iPhone, new cases

New 9.7-inch iPad
Apple just updated its most popular-sized 
iPad with a brighter 9.7-inch Retina 
display and its most affordable price 
ever, starting at recommended retail 
price of NZ$539 inc. GST for the 32GB 
with Wi-Fi model and RRP NZ$759 for 
the 32GB Wi-Fi + Cellular model. The 
128GB wifi-only models is NZ$699. It’s 
already available from Apple.com/
nz and starts delivering to customers 
and arriving next week through select 
carriers and Apple Authorised Resellers 
(prices may vary) in New Zealand plus 
over 20 other countries.
(iPad mini 4 is available in silver, gold 
and space grey, but now offers more 
capacity starting at RRP NZ$659 for the 
128GB Wi-Fi model and RRP NZ$879 for 
the 128GB Wi-Fi + Cellular model.

iPad are available 
for RRP NZ$69 
in charcoal grey, 
white, midnight 
blue, pink sand and 
(RED) from Apple.
com/nz (shown at 
bottom left).

New iPhone 
cases
In tandem with its 
new (Product)Red 
iPhone 7 models, and new seasonal band 
colours for Apple Watch, Apple released 
silicone and leather cases in the new 
colours azure, camellia and pebble.
The leather cases include sapphire, taupe 
(yetch!) and berry options.

iPhone SE doubles storage 
Apple is now offering the entry-level 
iPhone SE with 32GB of storage for the 
same price it ran for the 16GB model and 
128GB for the same price as the 64GB 
model. 
That’s double the previous storage for the 
same prices and heralds the end of the 
road for 16GB iPhones. [That last link also 
has a clip showing you how to gain space 
back on your iPhone.]

[To be clear, this is a new iPad, not a new iPad 
Pro or iPad mini. But this also means Apple 

has discontinued the 
iPad Air and older iPad 
mini 2 which used 
to sell alongside the 
mini 4. But this new 
iPad offers a newer 
processor & lower 
pricing.]

(PRODUCT)RED 
iPhone 7
Apple has introduced 
a (PRODUCT)RED 
version of the iPhone 
7 and iPhone 7 Plus. 
The (PRODUCT)
RED Special 
Edition iPhones are 
available at 128GB 
and 256GB starting 

at Recommended Retail Price (RRP) 
NZ$1399 from Apple.com and from Apple 
Authorised Resellers and select carriers 
(prices may vary). The special edition 
(PRODUCT)RED iPhone joins iPhone 7 
finishes in jet black, black, silver, gold and 
rose gold; these are NZ$200 cheaper ...

New iPad covers
Apple’s Polyurethane Smart Covers for Images this page: Apple Inc
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